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Chapter 1:  Introduction 

1.1 What is TracerPlus? 

Create enterprise class, barcode enabled, data collection applications in minutes for most tasks 
including asset management, inventory control, and many others with TracerPlus.  No 
programming knowledge is needed.  Simply create your familiar forms right on your PDA.  
 
TracerPlus incorporates time saving features that are not seen in any other applications. "Data 
Entry Validation", "Auto Find", and "After Scan Settings" are just a few of the features that will 
save you time and money. If you or your company has to collect data, TracerPlus is the right 
choice. 
 
Common TracerPlus Applications 
 

• Inventory Management. 
• Asset Management. 
• Library Book Tracking. 
• Remote Store Management. 
• Computer Management. 
• Job Material Management. 
• Time Tracking. 
• Trade Show Visitor Tracking. 

 
1.2 Free Trial 

TracerPlus is a shareware application.  A shareware application typically means that you can use 
it on a trial basis for no fee.   
 
The trial download is limited in that only allows 2 sessions can be created and only 5 records will 
transfer to and from the PC.  Once you decide to purchase TracerPlus, simply fill out the PTS 
Registration Request Page accessible from your PC’s Start Menu.  A registration code will be 
sent within 24 hours.  Alternatively, you can register from our website at http://www.ptshome.com.  
This registration code will activate your trial version, enabling it for full use; there is no need to 
reinstall. 
 
1.3 Learning TracerPlus 

To discover the full power of TracerPlus, we strongly recommend that you read this manual 
completely.  However, with only a basic understanding of Chapters 3 and 4, a user can begin to 
create basic applications with TracerPlus.  If you wish to send data to a PC or retrieve a database 
from the PC, Chapter 5 should be read thoroughly.  Finally, if a system administrator needs to 
deploy TracerPlus sessions to a mobile workforce, Chapter 6 should be read thoroughly.  In 
order to ease the learning process of TracerPlus, a registered user receives free email support for 
30 days from the date of purchase.  Purchase of extended support agreements is also available, 
offering both email and phone support. 
 
1.4  Barcoding with TracerPlus 

TracerPlus is designed to speed data entry with or without a barcode enabled PDA.  Drop down 
menus, time/date stamps and auto submit features allow users to collect data faster and more 
accurately.  However, to discover the full power of TracerPlus, we recommend using a barcode 
enabled PDA.  A list of the current barcode enabled PDAs supported by TracerPlus are listed 
below.  All of these units are available for purchase at http://www.ptshome.com. 
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Currently Supported Windows Mobile, Pocket PC and Windows CE.Net Bar Code 
Terminals include: 
 
Symbol PPT 2700 Series 
Symbol PPT 2800 Series 
Symbol PPT 8800 Series 
Symbol PDT 8100 Series 
Symbol MC 9000 Series 
Intermec 700 Series 
 

 
1.5  Integrating TracerPlus  

TracerPlus data can be ActiveSynced to the PC in one of six popular file formats.  Refer to 
Section 3.2.3 for a more detailed discussion on file transfer formats.  This flexibility makes it 
possible to integrate TracerPlus with most programs and databases.   Below is a list of the more 
popular programs and databases TracerPlus is integrated with. 
 

• Excel 
• Microsoft Access 
• Microsoft SQL Server 
• Oracle 
• MySQL 
• People Soft 
• FileMaker 
• FoxPro 
 

1.6 PTS Support 

As a registered TracerPlus user, you receive free email support for 30 days from the date of 
purchase.  During this period, we are available to answer TracerPlus questions as well as general 
barcode questions.  Our goal is to provide TracerPlus users the tools to capitalize on the 
efficiencies of bar code data acquisition.  Please visit http://ptshome.com/support.htm to learn 
more.  To contact PTS technical support, please email support@ptshome.com.   
 
Extended support contracts, including phone support can be purchased at 
http://www.ptshome.com/support.htm.   
 
PTS also hosts a TracerPlus User Group.  The group was created to offer our users a 
communication channel in which to discuss TracerPlus.   You can join the TracerPlus User Group 
at http://www.ptshome.com/support.htm. 
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Chapter 2:  Installation 

This chapter details the steps for installing TracerPlus.  
 
2.1  System Requirements 

• Windows 98/NT/2000/XP 
• ActiveSync version 3.5 or higher 
• A PDA or Bar Code enabled terminal running Windows Mobile, Pocket PC, CE.Net or CE 

version 3.0 or higher. 
 
2.2 Automatic Installation 

1. Download tracerp_ppc.exe from http://www.ptshome.com/downloads.shtml or 
another authorized reseller. 

2. Double click tracerp_ppc.exe in the folder to which you saved the download. 

3. Follow the standard installation instructions. 

4. The TracerPlus application is now ready for use on your portable device or will 
be available on your next ActiveSync depending on your configuration.  The 
TracerPlus application is located under Start Menu Programs on your PDA.  It 
is additionally available from the Shortcuts Taskbar after running for the first time. 

 
2.3 Installing TracerPlus on Multiple PDAs 

Before installing TracerPlus on multiple PDAs, it is recommended that each PDA be Synced at 
least once with ActiveSync and assigned a PDA user name. With TracerPlus installed on your PC 
use the PDA Installer to select the PDAs you want to install TracerPlus on.  The PDA install tool 
can be found on your PC, click on Start → Programs → PTS → Tracer Plus, and select the “PDA 
Installer” icon.  Then simply perform an ActiveSync for each PDA and TracerPlus will be installed. 
 

 
 
2.4 Registering TracerPlus 

TracerPlus is an application that requires registration for full functionality. The trial version of 
TracerPlus limits the number of records entered on the PDA and transferred to the PC to five, and 
the number of sessions to two. Once TracerPlus is registered, these trial limitations are lifted. 
 
PTS encourages all users who benefit from TracerPlus to register their copy. To register 
TracerPlus, we only require your TracerPlus PDA ID, your operating mode (Standard or Pro) and 
an Email address. We generate a unique registration code for your TracerPlus PDA ID and the 
version of TracerPlus you select, so it is important that you send the ID exactly as it appears on 
the TracerPlus splash screen; capitalization and spacing are critical.  
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How to Register:  
 

1. , click on Start – Programs – PTS – Tracer Plus, and select the “Registration 
Info” ico

     

On your PC
n. 

 
 

Locate the PDA IDs you wish to register, and click on the link to purchase the software.  
you are an existing user, follow the links for upgrading your license. If you have already 

2. If 

. 

3. mpleted and payment is received, you will receive an order 

4. 

5.  
e ask that you allow one business day in the 

6. your registration code, follow the instructions below to enter the code 

 
ntering Your Registration Code 

 

creen.  

4.  is valid, you will receive a Thank you for Purchasing 
TracerPlus message. 

2.5 Removing TracerPlus Installation 

 event that you would like to remove TracerPlus from your PDA, follow these simple 
structions. 

 
1.  feature in MS Windows via Control panel to Remove 

2. ttings\System\Remove Programs.  Highlight 
TracerPlus and select Remove.   

purchased TracerPlus through PTS or an authorized reseller please proceed to step 4

Once your purchase is co
confirmation from PTS.  

Complete, review and submit the Registration Info form on your PC.   

Note: Make sure that the correct version of TracerPlus is selected. 

Once this step is completed, your registration code is e-mailed to the address provided. 
This process usually takes one hour but w
event of heavy traffic or any other delay. 

Once you receive 
into your PDA.   

 
E

1. Start the TracerPlus application on the PDA. 

2. Click the Register button in the TracerPlus Splash S

3. Enter your Registration Code at the Code prompt. 

If the Registration Code

 

In the unlikely
in

Use the Add/Remove Programs
PTS TracerPlus from your PC. 
On your PDA  navigate to Start\Se
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Chapter 3: Sessions 

TracerPlus allows users to create up to 32 unique data capture programs. These unique 
programs are called Sessions.  Sessions are easily accessed from the Main Screen, where 
captured data can be viewed and searched.   In this section, you will learn how to configure 
session attributes to meet your data capture needs.  Chapter 4 details how to configure individual 
fields within a Session. 
 
3.1  Configuring Session Attributes 

The first step in creating a TracerPlus Session is to assign a name. This name is displayed in the 
session menu, and is selected by the user when collecting data, editing field settings, or editing 
session settings. To create a Session name, follow the steps below. 
 
1. From the data view screen select the Options menu button. 
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2. Select Session Settings.     3. Select the New button.  
 

           
   

 
4. Enter the name of the session you are creating. 
  

     
 
5. Configure your session’s General, ActiveSync, Data and Backup attributes as described in  
Sections 3.2.1-3.2.4. When you are finished, press Done.  If you do not need to modify the 
session, the default settings will be used and you can proceed directly to Field Settings, 
Chapter 4, if you wish to use default session settings. 
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3.2 Session Settings Explained 

3.2.1 General Session Settings 

General Session Settings are used to control the general operating characteristics of the session.  
These operating characteristics cannot be set at the field level. 
 

     
 
Start On Screen 
Select the screen the User will enter when they leave the TracerPlus Splash Screen.  The user 
can choose between starting on the Main Screen or the Data Entry screen.  Note that this option 
takes effect only when this session was the last one used – each session has its own settings. 
 
Start On Field  
Select the first field the User is focused on when New is selected from the data view screen.  This 
setting is commonly selected to control what data must be entered when the program is initially 
opened.   
 
Example: A session is created to capture package delivery information. Date and Time 
stamps are captured in fields 1 and 2.  The bar-coded Package ID will be entered into is Field 
3.  In this scenario the Start On is set to Field 3 since Field 1 and 2 are auto entered via 
automatic date and time stamps. 
 
Edit on scan/Find in grid 
Select Edit on scan/Find in grid to automatically open records in the data entry screen when a 
record is located using ‘Find’ or scanning on the main grid screen.  Note that the Find Field 
affects which field’s data is used for searching. 
 

Example:   A session is created to perform an inventory audit.  The goal of the audit is to quickly 
find items in the TracerPlus database and compare the database values to the actual inventory 
levels.  To speed this process, the Edit on scan/Find in grid setting is enabled.   When an item is 
scanned in the find field and located in the database, the matching record is automatically brought 
up in the data entry screen for editing. 
 
Edit on Click in Grid 
A similar option for automatically editing a record is the behavior of editing a record immediately 
upon clicking it in the grid. Selecting this option is very useful for the user who is performing a lot 
of edits to existing data. 
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Note: When this option is selected, it is not possible to delete a single selected record from the 
grid.  The user must turn this option off before being able to delete single records.  The Delete All 
menu choice behavior is not affected. 
 
3.2.2 Import/Export Settings  

Import/Export settings are used to control how data is moved from your PDA to PC.  
 

     
 
Delete Data After Export 
Select Delete Data After Export if the data should be removed from the PDA database after a 
successful Export.  Note that if data is not successfully exported, as a safety precaution, it will not 
be deleted from the PDA Database even when this option is enabled. 
 
Archive PC Data After Import 
Select Archive PC Data After Import if you wish to archive any files imported from PDA during 
an Import.  Any data files successfully imported  are renamed with a prefix of “old_” after a 
successful Import if this option is selected.  Import files include both list contents as well as any 
session data needing import to the PDA.   
 

Note:  Without this option, your upload files will be uploaded every time you perform a import, 
which may cause the import process to take longer than necessary. 
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3.2.3 Data Storage and Transfer Settings 

Data settings are used to control the format of the session’s data file exported via File->Export. 
 

    
 
Export As 
This option allows the user to select from one of five possible data formatting types 

 
Text (Tab delimited) 
This formatting option embeds a <tab> character between every transferred field.  Each 
record is terminated with a Carriage Return/Line Feed (CRLF) 
 
Text (Comma delimited) 
This formatting option wraps each field in quotation marks and separates each field with a 
comma.  Each record is terminated with CRLF. 
 
Text (Fixed Width) 
This formatting option transfers all fields using a fixed width.  Any space remaining at the 
end of Field data is padded with spaces.  Use of the Max Length field setting is also used to 
dictate the width of each fixed width field.  The maximum length of any given field is 30 
chars.  Each record is terminated with CRLF. 
 
XML 
This formatting option allows data to be transferred in XML format.  This is very useful for 
customers when importing into existing systems. 
 
HTML 
This formatting option transfers all data in HTML table formats.  This provides a formatted 
representation of the collected data that can be viewed as a web page. 
 
Text (Comma, No Quote) 
This formatting option separates each field with a comma.  Each record is terminated with 
CRLF. 

 
Append to Existing File  
By default, TracerPlus appends new data to any existing data file in the FromPDA export folder.  
When this option is selected, the new data file is appended to the pre-existing file if it exists.  If 
this option is not selected, any previously transferred data is deleted and a new file is created on 
each Export operation.  A new file will be created if it does not exist regardless of this setting, 
however. 

TracerPlusM-0002.110  12 



Chapter 3: Sessions 
 
 
Send Non-Visible Fields 
By default, TracerPlus does include non-visible fields in the data file.  When this option is 
selected, non-visible fields will be sent to the export file. Refer to Chapter 4 on how and when 
you might use this option. 
 
Include Field Names 
By default, TracerPlus does not include field names in the export data file.  When this option is 
enabled, the user configured field names are provided in the generated data file.  Depending on 
the file format, this is represented in different ways.  For all of the text data transfers, the Field 
names are included as a header record, being transferred as the first line of the data file.  For the 
XML and HTML formats, the field names are included in the general formatting of the data file.  
 
3.3 Deploying Configured Sessions to Multiple Users 

Please refer to Chapter 6, Section 6.2 for a detailed look into how to deploy session 
configuration to your entire workforce. 
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Chapter 4: Field Settings 

After a session is created, fields within that session may also require configuration.   Before 
configuration, all available fields within the session are in a default state.  TracerPlus Standard 
had 10 fields available for configuration and TracerPlus Professional has 30 available fields. 
 
Customizing your session settings and field settings is not required, as the default settings will 
work perfectly for many users.  However, to fully realize the power of TracerPlus, some of these 
settings may need modification for your specific needs.  Proper field configuration may speed up 
data acquisition and may prevent data input errors, again, depending on your collection 
requirements.  
 
In this chapter, you will learn how to set up fields for your specific application. Section 4.2 
explains the various TracerPlus field settings in more detail. 
 
4.1 Configuring Field Settings 

Below we go through the steps required to configure field settings. 
 
1. From the TracerPlus Main Screen, select the Options menu button.    
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2.  Select Field Settings.            3.  Select a TracerPlus session. 
         

         
 
4.  Select a field to configure.  
5.  Enter the field Name.  
 

     
 

6.  Select a Field Type.  Section 4.2.1 discusses these field types in more detail. 
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7.  Enter General field settings.  Section 4.2.2 discusses these settings in more detail. 
 

     
 
8.  Enter additional field settings.  Refer to Sections 4.2.3 through 4.2.5 for more detail on the 
other available field settings options.  
 
9.  Repeat steps 4-8 to configure additional fields. 
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4.2 Field Settings Explained 

4.2.1 Field Types 

The Field Type setting is used to control what type of data is entered for this field.  TracerPlus 
has four available Field Types:  Text, Drop-Down, Checkbox and Variable.   
 

     
 
Text 
Text fields should be chosen when data is to be entered via a bar code, keyboard, or graffiti.  The 
Text type does not restrict input in any way, and can store up to 30 characters. 
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Drop-Down 
Drop-Down fields allow the user to select from a pre-defined list of items. Drop-Down fields offer 
a quick, error free way to enter data from a select list of choices.  Section 4.2.5 provides more 
detailed information regarding drop down lists. 
 

     
 
Check Box 
Check box fields are used when simple Yes/No, True/False, On/Off selections are made.  Check 
boxes should be used whenever possible to speed data entry, and limit data entry error. 
 

    
 
Variable 
Variable fields are used to automatically enter values such as Time and Date.  To set a Variable 
field the user selects the value they would like to enter in the field from the drop down menu.  The 
selected setting will then appear in the “Default” field value in the Settings screen.  By default, 
Variable field values are populated when the record is first created. To update the variable each 
time it is submitted, simply enable the Update Variables option for that field.  Refer to Section 
4.2.4 for more information regarding Update Variables. 
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DATE 
When DATE is selected the current date is automatically entered in the field in the 
mm/dd/yyyy format (i.e. 05/07/2003). 
 
TIME 
When TIME is selected the current time is automatically entered in the field in hh:mm:ss 
military format (i.e. 19:19:55). 
 
DATETIME 
When DATETIME is selected, the current date and time are automatically entered in the 
field in the mm/dd/yyyy hh:mm:ss format (i.e. 05/07/2003 13:14:55). 
 
TIMEHHMM 
When TIMEHHMM is selected the current time is automatically entered in the field in the 
hhmm format (i.e. 0915).  The first two digits represent the hour the next two digits 
represent the minutes past the hour. 
 
DATE2 
When DATE2 is selected, the current date is automatically entered in the field in the 
yyyy-mm-dd format (i.e 2003-05-07) 

                                   
4.2.2 General Field Settings 

General Field Settings allow the user to define the most basic field attributes. These settings 
allow a TracerPlus user to remove visibility of a field, establish default values, numeric only fields, 
and read only fields. 
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Data Type 
The Data Type represents the format of the expected data for the selected field. 
    

       
 
General 
General is set to accept all data types in a field, including date time stamps. 
 
Numeric 
Numeric is set when the field is only used for numeric data.  When a field’s Data Type is 
set to Numeric, it does not accept any Alpha characters. 
 
Date 
Date is set when the field is used to enter dates.   
 
Time 
Time is set when the field is used to enter times. 
Note: Time data is always stored in military format.   

  
Default 
The Default represents the value that is initially used for the selected field. For example, you may 
set up one of your fields to represent a quantity. Likewise, you might want to set the Default for 
that field to be 1. 
 
 

Note 1: If the user clicks the Clear All button from the data entry screen, this value is cleared, as 
well. 
 
 
Default values can also be entered using Variable field settings.  Refer to Section 4.2.2 for more 
information. 
 
Visible  
This option is normally selected and allows a field to be viewed or hidden in the data entry 
screen.  A field’s visibility should be turned off when it is not being used in a session or if the 
default contents need to be stored but not seen by the user as in some cases of Date/Time 
stamping of an individual record.  
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Show in Grid 
When Show in Grid is selected, the field is visible in the Main Screen grid. Fields are displayed 
in their numeric order in the grid.  
  
Read Only  
When the Read Only option is selected, the user does not have the ability to enter data in the 
selected field. This is commonly used in conjunction with default values and Variable type fields. 
 
4.2.3 Validation Field Settings 

Validation Field Settings allow the user to exhibit controls that check the accuracy of the entered 
data.  
 

     
 
Validate Immediately 
This option represents whether or not a field should be validated immediately after it is entered. 
When Validate Immediately is not selected and Validation settings do exist, the field data will 
still be validated when the record is submitted. 
 
Unique in Table 
When selected, this option prevents duplicate data values within the current session. If a field is 
submitted and it violates the Unique in Table setting, an audible alarm and error message is 
displayed. 
 
Unique in Record 
When selected, this option prevents duplicate data values within the current record. If a field is 
submitted and it violates the Unique in Record setting, an audible alarm and error message is 
displayed. 
 
Min Len   
This option allows the user to validate an entry based on the minimum number of characters 
required.  If a field is submitted with less than the “Min Len” setting, an audible alarm and error 
message is displayed.  Setting a Min Len of 1, for example, prevents the user from leaving that 
field blank.  
 
Max Len  
This option allows the user to validate an entry based on the maximum number of characters 
allowed.  If a field is submitted with more than the “Max Len” setting, an audible alarm and error 
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message is displayed.  Specify a Max Len of zero to disable this rule.  Fields in TracerPlus can 
store up to 30 characters. 
 
4.2.4 After Scan Field Settings 

After Scan field settings are designed to increase data entry speed and accuracy. Repetitive 
data capture scenarios such as inventory audits lend themselves to the efficiencies of these 
settings. It is recommended that these features be activated whenever possible. 
 

NOTE: The ‘After Scan’ rules are triggered by both a completed barcode scan as well as pressing 
the Down Arrow key on your PDA. 

 

     
 
 
Auto Submit  
This option represents whether or not to automatically submit this record following an 'After 
Scan' event for this field. If this option is chosen for the selected field, the system automatically 
submits the record and sets the focus to the field selected in the Go To prompt for the selected 
field.  The form is then ready for a new record. 
 
Clear On Submit  
This option is used to tell the system whether to clear the selected field after submitting the 
current record in the Entry screen. If the current record is submitted as a result of an ‘After Scan’ 
event or by clicking the Submit button, all the fields with this option selected are cleared. If the 
field has a Default Value, that value is used instead of a blank entry.  Turning off Clear On Submit 
is especially useful if several records in a row will share a value for a field – it saves the user the 
time of re-entering the same data when entering several new records. 
 
Auto Find on Scan 
This option allows the user to perform a lookup of entered data for this field.  If the item is found, 
the user is moved to this record and is placed in edit mode for this record. 
 
Update Variables 
When this option is selected, Variable field data is updated to represent the variable value at the 
time that the record was submitted as opposed to the default operation of using the time that the 
record was created. This is really only relevant for date/time based variable settings and should 
usually be turned off in any other variable field.  This is useful when you want to track the 
date/time a record was edited, rather than created. 
 

TracerPlusM-0002.110  22 



Chapter 4: Field Settings 
 
Go To  
This option allows the user to control the ‘tab order’ for the selected field. After a user performs a 
successful scan while in the focus of the selected field, the system sets the focus to whichever 
field is selected as the Go To Field.  The user typically uses this feature to control the 'flow' of 
data entry. Alternatively, the Down Arrow key represents an 'After Scan' event for those PDAs 
that are not barcode enabled. 
 
4.2.5 Drop-Down Lists 

Drop Downs allow TracerPlus users to create their own Drop-Down list menus for specific fields.  
TracerPlus gives the user the ability to create these lists either directly on the PDA or from a file 
on the PC via a ActiveSync data transfer.  
 

     
 
Allow PC Update  
This option allows the user to create drop-down lists on the PC.  During ActiveSync these lists are 
loaded into the field and overwrite any existing drop-down information saved on the PDA.  For 
this reason, we offer the ability to disable the PC Update option.  This gives the user the ability to 
avoid accidentally overwriting any existing list information created on the PDA. 
  
If you wish to allow list contents to be uploaded from the PC for a particular session and list, this 
option should be checked.  If you wish to prohibit the PDA from getting updated list contents from 
the PC, simply uncheck this option.  Chapter   5 refers to PC Operations in more detail.  Please 
refer to that section for more detail regarding list updates from the PC. 
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Modify 
Select the Modify button to directly edit the list contents on the PDA.  We discuss the steps in 
creating drop-down list items in the following section. 
 
1. Select Modify.     2. Select New. 

 

                 
 
3. Enter a List Item via keyboard.  Click Done when finished 
4. Repeat steps 2-3 to add additional list items. 
 

     
 
TracerPlus List Items can be edited and deleted in the TracerPlus Lists screen.  Simply choose 
the value to be edited and select the appropriate button. 
 

NOTE: List Items may also be deployed to multiple users.  In most multi-user cases, the PC update 
option would be used, but it is also possible to create a list on one PDA and distribute to your entire 
mobile work force.  Refer to Chapter 5 for more information regarding this powerful feature. 
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Chapter 5:  Managing Data 

5.1 Entering Data 

To enter data in TracerPlus, the user must first select the appropriate session.  Once that is 
selected, clicking the New button will start the data entry/collection process.  
 
Entry Screen 
The Entry Screen is the area where the user does data entry. The fields are presented to the 
user with the customized fields as they were configured. The user enters data for each field 
presented. When the data is being scanned, the system controls the flow to the next field based 
on the Field Settings previously set up.  This screen contains three buttons. These are discussed 
below. 
 

 
 

Done Button 
Click the Done button when you have finished entering data and would like to return to 
the Main Screen. You will be prompted as to whether you would like to save the last 
record. Answer appropriately. You will now be returned to the Main Screen. 
 
Submit Button 
Clicking the Submit button submits the current record to the database. After clicking this 
button, the focus is set to the field that was set as the Session Start On field. Refer to 
Section 3.2.1 for more information on setting a Start On field. 
 
 
Clear All Button 
Clicking the Clear All button clears all data from all fields for this record. Notice that the 
focus does not change after clicking this button. Also notice that any Default values 
selected in the Field Settings are not recognized. 

 
5.2  Editing Data from the Main Screen 

The Main Screen is the area where the user can review, edit and search for records 
previously entered.  The user can delete or edit a record by selecting it and then tapping a 
function key.  For more information on searching for records review section 5.4. 
 
 Delete 

Click the Delete button to delete the selected record. 
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Edit 
Click the Edit button to edit the record in the Data Entry screen.   

 
5.3  Quick Buttons 

TracerPlus specializes in streamlining screen interaction.  We do this through implementation of 
several unique features.  This allows for very fast and accurate data entry.  One of the features to 
aid in this is using the Up/Down keys on your PDA. 
 
The Up Arrow key allows the user to move up one field on the Entry Screen.  Note that this 
does not follow the ‘Go To’ field settings.  It simply moves up one field on the Entry screen) 
 
The Down Arrow key allows the user to move down one field in the Entry Screen.  The Down 
Arrow key is actually used to trigger the ‘After Scan’ rules and TracerPlus behaves just like it 
would after receiving a valid barcode scan. If, for example, the Auto Submit flag is enabled for 
the current field, and the user presses the Down Arrow key, the current record is submitted and 
all of the After Scan field settings for the field are respected; including the ‘Go To’ Field.  This is 
especially useful for the users that do not have a barcode enabled PDA. 
 
5.4 Finding Data 

While in the Main Screen, TracerPlus users can search the session database while by using the 
Find feature.  Follow the directions below to use the find feature. 
 
 

1. Select a field to search.             2.   Scan or enter data into the Find Field.   
     3.    Click the Find button.  
 

         
 
If you are manually entering data, you must click the Find button.  If you are scanning data, this is 
done automatically when you scan a barcode value.  Additionally, there is a session setting that 
enhances the operation of this Find feature.  Using Session settings, you may set the option to 
Edit on Find.  Refer to section 3.2.1 for more information regarding these settings. 
 
5.5 Managing Data from the PDA to the PC 

TracerPlus allows easy data transfer between the PC and PDA via simple Import and export 
commands available from the PDA menu options.  This section outlines all of the features 
available for PC processing. 
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5.5.1 How Data Is Sent to the PC 

TracerPlus transfers all session data to the PC via standard Import/Expor options.  Importing and 
exporting allows for exchange of data between the PDA and the PC during ActiveSync.  
Depending on your ActiveSync settings, the mapping to these TracerPlus generated files can be 
done automatically.  Before initiating the process the user must first select File -> Export Data on 
the PDA.  Imported and Exported data is available on the PDA at \\My 
Documents\TracerPlus\FromPDA and \\My Documents\TracerPlus\ToPDA.  These links provide 
you access to all of your imcoming and outgoing TracerPlus data.  Each session defined on the 
PDA generates its own independent data file.  These files are appropriately named using the 
session number of each given session.   
 
You can see the session number of any given session via the TracerPlus Main Screen or in the 
Session Settings dialog screen on the PDA.  These numbers typically follow the order in which 
each session was created but this is not always the case.  It is important to note what these 
session numbers are when looking for your data.  The filename for each session is Sxx_data.txt 
where xx = the session number for that session. 
 
For example, if you have 2 sessions defined on the PDA, the first session listed would generate a 
file named S01_data.txt and the second defined file generates a file named S02_data.txt. 
 
5.5.2 Viewing Data Files on the PC 

Data files sent to the PC can be quickly viewed by selecting the appropriate file setup for 
synchronization mapping via ActiveSync. 
 
5.5.3 Linking TracerPlus Session Data to an MS Access Table 

Microsoft Access is an affordable and popular database that can be utilized to manage 
TracerPlus data. To import TracerPlus session 1 data, file name S01_data.txt, follow these 
steps: 
 

1. In MS Access, open your database or create a new database. 

2. Select File. 

3. Select Get External Data. 

4. Select Import. 

5. In the Import dialog box, select Files of type: Text files (*.txt). 

6. In the file name list box enter the path to S01_data.txt created on the PDA. 

7. Select Import. 

8. Follow the Import Wizard steps to complete the import. 
 
PTS also offers an add-on product to directly connect to your ODBC database (including MS 
Access) that may be a better solution for many users.  This application is discussed in more detail 
in section 5.6.5, or visit www.ptshome.com for more details about ODBC Link for TracerPlus. 
 
5.5.4 Linking TracerPlus Data to an MS Excel Worksheet 

MS Excel allows text files to be opened directly in Excel.  Following just a few simple wizard 
dialog screens allows most users to painlessly view their data in an easy to read MS Excel 
worksheet.  
 

1. In MS Excel, select File Open. 
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2. Browse to the TracerPlus generated text file. 

3. Select the file and Click Open. 

4. Answer any questions regarding the type of data file as is appropriate. 

5. You should now see your TracerPlus data displayed in MS Excel in a familiar 
spreadsheet format. 

 
5.6 ActiveSyncing Data from the PC to the PDA 

TracerPlus allows you to send databases from the PC directly to your TracerPlus sessions on the 
PDA.  Our customers find this an invaluable tool and utilize it many different ways.  For example if 
an inventory control manager needs to distribute pick lists he simply saves the inventory file to the 
\\My Documents\TracerPlus\ToPDA folder on the PDA for later import to TracerPlus.  If a 
maintenance manager needs to distribute jobs, he distributes the job files to the maintenance 
personnel’s \\My Documents\TracerPlus\ToPDA folder.  The scenarios in which this feature can 
be used are limitless! 
 
Many of our customers connect their TracerPlus sessions with 3rd-party databases to give their 
current systems added functionality.  By exporting their databases from Microsoft Access, Excel 
or any other database,  these data files can easily be created and distributed. 
 
5.6.1 Sending Session Data to the PDA 

All data prepared for upload to the PDA must be stored in a folder called ToPDA.  This folder 
must be located under the \\My Documents\TracerPlus\ folder on the PDA.  These folders are 
automatically created when running TracerPlus on the PDA. 
 

Note: If you are using the Custom ActiveSync Folder feature (Pro version only), the ToPDA folder 
will be located in the Custom ActiveSync Folder you specified under Session Settings ActiveSync 
 
TracerPlus allows tab-delimited files to be sent from the PC to the PDA.  The data file must be 
named exactly the same as the data generated by the ActiveSync process. So, for example, if 
you want to upload data for Session 2 on the PDA, the filename must be S02_data.txt and must 
be located in the ToPDA as described above.  Once the PDA is ActiveSyced the user simply has 
to select file Import data on the PDA and the data will be available in TracerPlus  . 
 
The required file definition for sending session data from the PC to the PDA is as follows.  <CR> 
indicates a carriage-return (line break), and <tab> indicates a tab character. 
 

Field1<tab>Field2<tab>Field3<tab>….Field9<tab>Field10<CR> 
Field1<tab>Field2<tab>Field3<tab>….Field9<tab>Field10<CR> 
  

Below is a sample data file prepared for upload to a TracerPlus session.  
 

 
 
A sample upload session file is located with this install.  If you wish to test the functionality of this 
feature, simply place that sample file in the ToPDA subfolder and set its name to the appropriate 
session. 
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Note: If you define data for a session number that does not exist on the PDA, it will be ignored. 

 
Note for New Users of Windows: Some versions of Windows will not display the file extension 
(e.g., “.txt”).  On those systems, if you save a file as “S01_data.txt”, it will actually store the file as 
“S01_data.txt.txt”.  This file will not be recognized by TracerPlus.  To check the actual name of a 
file you’ve created, right-click on it in Windows Explorer and choose “Properties”.   
 
5.6.2 Creating Session Data Files with Excel 

To create a session data file with Excel, follow these steps. 
 
     1. Open the file in Excel      
     2.  Select File from the Menu bar 
     3.  Select Save As 
     4. In the Save As dialog box, select Save As Type: Text (Tab Delimited) 
     5.  Save your session to  

\\Mobile Device\\My PocketPC\My Documents\TracerPlus\ToPDA\S01_data.txt 
     6.   Close the Excel file 
     7.  Perform a File Import from TracerPlus on the PDA. 
 
5.6.3 Sending Drop-Down Lists to the PDA 

TracerPlus also allows the user to prepare and manage Drop-Down lists on the PC for later 
upload to the PDA running TracerPlus.  The filename of list data to be uploaded must be named 
SxxFyy.txt where 
 xx = the session number 
 yy = the field number 
 
For example, if you want to send the list contents for session 2 in the 4th field, the filename must 
be named S02F04.txt.   
 

Note:  Simply sending the list contents for a particular session and a particular field does not 
automatically define that field as a drop down list.  This must still be set in the Field Settings 
screen of the PDA application.  Please refer to Chapter 4 for instructions on setting field properties.
 
The format for the list files is very simple.  Each list element must be stored on its own line.  Since 
there is only one field, there is no need for a <tab> delimiter between fields.   
 
A sample of what this data must look like is as follows.   

 

 
 
A sample upload list file is located with this install.  If you wish to test the functionality of this 
feature, simply place that sample file in the ToPDA subfolder and rename it to the appropriate 
session number and field number. 
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Chapter 6: Administration Settings 

Once sessions are configured, it is customary to implement password protection so field 
personnel cannot easily alter the session settings. When a Password is set, a user is required to 
enter this Password to access any areas protected by the TracerPlus Admin Settings.  
Administrators commonly Enable Protection for Session Settings and Field Settings.  Below 
you will learn how to set Passwords and set protection levels for program settings as well as data. 
 
6.1 Setting Passwords 

1. Select Passwords in the Grid Screen 2. Select Use Password 
 3. Enter your Password 
 4. Enter additional protection levels; Session 

Settings, Field Settings, Delete One 
Record, Delete All Records and Edit 
Records  

 

          
 
6.1.2 Enable Protection for 

Session Settings 
When protection is enabled for Session Settings, the user is required to enter a password to edit 
or add sessions. 
 
Field Settings 
When protection is enabled for Field Settings, the user is required to enter a password to edit or 
add field information. 
 
Delete One Record 
When protection is enabled for Delete One Record, the user is required to enter a password to 
delete a record from the data view screen. 
 
Delete All Records 
When protection is enabled for Delete All Records, the user is required to enter a password to 
delete all records from the menu bar. 
 
Edit Records 
When protection is enabled for Edit Records, the user is required to enter a password to edit a 
record. 
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6.2 Deploying Configured Sessions to Multiple Users 

6.2.1 How to Copy One PDA Configuration to Other PDAs 

As of version 1.0, this option is not yet available in TracerPlus for Pocket PC. 
 
6.2.2 File Names Used by TracerPlus 

This section lists the various file names used by TracerPlus on the PC.  It is here for your 
reference in deploying and troubleshooting your TracerPlus configuration. 
 
Note that sessions are identified by their session number, e.g. “S01”, and fields are identified by 
their field number, e.g. “F02” (with “S01F02” indicating the first session and second field). 
 
Upload Filenames:  (located in the “ToPDA” folder) 
 
 Data Records S01_Data.txt 
 Drop-Down Lists S01F02.txt 
 
Backup Filenames: (located in the “Palm\username\backup” folder) 
 
 Session definitions PPTP-TracerPlus_Sessions.pdb 
 Data Records PPTP-Data_S01_30.pdb  (Pro mode) 
 Data Records PPTP -Data_S01_10.pdb  (Standard mode) 
 Drop-Down Lists PPTP -List_S01F02.pdb 
 Bitmaps (signatures) PPTP -Bitmap_S01.pdb  (Pro mode only) 
 Field Hints PPTP -Hint_S01.pdb  (Pro mode only) 
 Print Formats PPTP -TracerPlus_Formats.pdb (TracerPlus Print only) 
`   
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